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== Supplier Catalog Template

1. Introduction

1.1 Purpose

The purpose of this document is to assist suppliers with the generation of a valid Excel spreadsheet to create or maintain
their catalog items in FedMall.

1.2  Audience

The intended audience of this planning document is:
U FedMall Suppliers
U FedMall Program Managers

d Communication Leads

1.3 Document References

This document is based on the following documents:

Document Name Version Owner
FedMall Supplier Catalog Template Spreadsheet V0.1.6 IBM
FedMall QSG Catalog Template v0.1.6 document.docx Status: Review
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2 Instructions

2.1 Summary of Procedure

e Complete the “Catalog Template” sheet with your catalog details. Do not modify the number or the order of
the columns.

e Reference the “Field Descriptions” sheet and the “Additional Information” sheet for help on completing the
data entry. You may leave optional fields blank.

e If the item already exists in FedMall, it will be overwritten. If it does not already exist in FedMall, it will be
added. To delete an item, enter a “Y” in the first column (Archive); otherwise, leave the first column blank (or
specify “N” in the first column).

e When complete, upload the file to FedMall via the Supplier Portal.

2.2 Catalog File Details

File Type The file should be a plain text file with a .csv extension.

Row Header Use the headings on the “Catalog Template” sheet. The uploaded .csv file must include the headings as its
first row.

Field Delimiter Each field should be separated from adjacent fields with a delimiter, which is the caret ( 2 ) character. If you

want to use Microsoft Excel to create your data file and then export it to delimited text, instructions are
provided below.

Rows At present, you may insert a maximum of 10,000 rows of data (plus the one header row). This limitation is
subject to change following performance testing.

File Size The size of the file will vary not only with the number of rows of data, but also with the content of each row.
The file should not exceed a maximum size of 20 Megabytes to support effective performance. This
limitation is subject to change following system performance testing.

2.3 Managing Images

All images are uploaded in an archive (.zip) file separate from the main catalog spreadsheet. Please see the “Image
Upload Specification” spreadsheet for complete details about how to structure that image file archive.

24 Using MRCs to Specify Additional Characteristics

The final field in the template, “Characteristic Information,” represents a series of code-value pairs, where the code is a
Master Requirements Code (MRC) as listed in the Master Requirements Directory (MRD), which in turn is managed by
the Defense Logistics Agency (DLA) Logistics Information Services (DLIS).

You may search for individual codes in the Supplier Portal by accessing Product Information Management and
adding/editing an item. Alternatively, you will find complete current tables of MRC codes and their meanings at:

e  https://www.dlis.dla.mil/extracts

FedMall QSG Catalog Template v0.1.6 document.docx Status: Review
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25 Managing Number and Date Formats in Excel

If you are using Microsoft Excel to edit your data file (.csv), Excel may try to automatically convert the format of your numbers and
dates from the required format. Examples include:

e  Long numbers: If you enter a very long value, such as a part number, that only contains the digits 0-9, Excel may try to
interpret this as a long number and display it in scientific notation (e.g. “1234567890123"” would display as
“1.23457E+12").

e Dates: If you enter a value that Excel believes is a date, it will attempt to convert the value to its own format (e.g. “2017-
01-24”, which is in the correct format, may be changed to “1/24/17” by Excel).

e  Values with a leading zero: Excel will recognize that a CAGE code or part number with letters in it is text, e.g. “012AB”;
however, if the value is all-numeric and starts with a zero, Excel will treat it as a number and trim the leading zero (e.g.
“02468” is converted to “2468").

Essentially, in all of these examples, Excel is attempting to format your data for you, when you want the data to be stored exactly as
you enter it.

2.5.1 First step: Understand the format that is actually saved in your file

If you have an existing .csv file, the way to ensure that you understand what is actually in that file is to open it in a plain text editor,
such as Notepad, rather than in Excel. To do this, you may choose one of these options:

e  Open Notepad (from the Start menu), then select File -> Open, and open the .csv file.
e  From Windows Explorer, right-click the file, select “Open With...” and then choose Notepad (or another text editor, such
as Notepad++).

B:S o 8/2017 11:37 PM  Microsoft Excel C... 1KB
Print
[ Edit with Notepad++
Scan for Viruses...
Open with 3 Excel 2016
Publish into Privia... J Notepad
[Zf MNotepad++ : afree (GNU) source code editor
Restore Previous versions _fr OpaﬂOf‘Fi{a Calc

Send to D Choose default program...

Symantec Encryption Desktop 3

F—

2.5.2 Entering new data into a template

If you are creating a new catalog from scratch, you will want to start with a template. FedMall provides a sample template in
addition to this Quick Start Guide. Before entering data into a blank cell, ensure that the format is correctly set to “Text.” Change
the format of the cell(s) in question to “Text” instead of “General” or “Date.” You may do this globally for all cells in the template
you are working with. (Hint: to select all cells at once, click any cell, and then tap Ctrl-A on your keyboard.)

FILE HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER ADD-INS
e X Cut n of =
2DEE Arial -0 AN = - EeWapTet Text =: ¢
P E@ Copy C d';': | F -
aste I u-~ .| & . |l=== &= = M &C $ - Or .0 .00 onditional Format as
a . u = = = & = = Merge enter o ? T ]
- ¥ Format Painter L 2 ’ Formatting - Table -
Clipboard ra Font ra Alignment P} Mumber P
R2 - I
M o] P Q R 3]
tem Master Primary
tem Master Primary ltem Master Primary Spac/Commercial
Spec/Common Spec/Common Information/Environmental | ftem Master Primary ltem Master Primary
Infermatien/Days After ltem Master Primary Information/Universal Information/Hazardous Speci/Sale Pricing/Sale Start |Spec/Sale Pricing/Sale End | fem
1 |Receipt of Order Spec/Long Description Product Code WMaterial Flag Date Date Spe
2|
3
A
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2.5.3 Working with an existing file

If you already have a .csv file and you open it in Excel, you may notice that Excel converts the values to their numeric and date
formats automatically. This may happen when you open the .csv file: (1) from Excel’s File -> Open menu, or (2) by double-clicking on
the .csv file in Windows Explorer to open it in Excel.

To avoid this issue, you may want to import the data when you open the file, rather than opening it directly. To do this, open Excel
to a blank workbook. Before you import your data, set all fields in the worksheet to Text (as described in section 2.5.2), and select
the “Get Data from Text” option from the Data tab.

Home Insert

Page Layout Formulas

D F [ Show Queries |—|rb, 2]
s |
X I:l E Fram Table Lol
Existing New Refresh
Access  Web z Connections  Query ~ DP' Recent Sources All-
ef External Data Get & Transform Conn
a1 Get Data From Text
Import data from a text file.
A B C D E F G
1 |
]

Select your .csv file in the Open dialog box, and then proceed through the steps of the Text Import Wizard. In Step 1, choose
“Delimited” and select the check box next to “My data has headers.”

The Text Wizard has determined that your data is Fixed Width.
If this is correct, choose Next, or choose the data type that best describes your data.
QOriginal data type

Choose the file type that best describes your data:
@) Delimited

() Fixed width

- Characters such as commas or tabs separate each field.
- Fields are aligned in columns with spaces between each field.

Start import at row: |1 = File grigin: 437 : OEM United States

Preview of file &\don\DLA\Training'\Quick Start Gui.. \Q5G_Sample_20170131_Zrecords_UTF-8.csv.

[tem Master Primary Spec/Item Status Information/Archive~Item Master Pril

1
E ~0Z188~MARFETPLACE 0Z1B828~DN12345~Stamp, & Digit Numbr Pru“?&lO“ZO.SS“Eh“|_
~0Z128~MAREETPLACE 0Z1B828~123ABC45~Lzbel, Heat Shrink, 1/4-inch, White~7§

4

Cancel

< Back

-

In Step 2, specify that the delimiter is a caret ( ~ ) by checking the “Other” box and typing a caret in the blank field.

FedMall QSG Catalog Template v0.1.6 document.docx
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Text Import Wizard - Step 2 of 3 [

This screen lets you set the delimiters your data contains. You can see how your text is affected in the
preview below.

Delimiters

[ 1ab

[7] semicalon [T Treat consecutive delimiters as one

|:| Comma . E|

Text gualifier:
[T space

Other: | *

Data preview

tem Master Primary Spec/Item Status Information/Archive Ttem Master Primax] #
Zls8
2188

¢

[ cancet | [ <sack | [ mew> | [ enisn

In Step 3, you may leave the default settings (“General”) for most fields, because you already set all
started the import wizard. However, Excel will still try to convert the date formats, so be explicit for

fields to “Text” before you
the Sale Start Date and Sale End

Date by selecting each of those columns in turn and choosing “Text” from the list of column data formats.

This screen lets you select each column and set the Data Format.

Column data format

neral
‘General’ converts numeric values to numbers, date values to dates, and
Text: all remaining values to text.

Come wor [1]

") Do not import column [skip)

Data preview

tem Master Primazy 3

017-05-30

In the final step, you will be able to select where the imported data should go (e.g. cell Al of your cu

Your imported data will now be presented as all text values.

.
Text Import Wizard - Step 3 of 3 oo |

rrent, blank spreadsheet).

2.6 Exporting a Text File from Excel

You may create your catalog file in any text editor. You may also find it convenient to use Excel to maintain your data and then

export the data from Excel to the delimited text file for import into FedMall.

e  First, change your delimiter (“list separator”). Open Control Panel and then the “Region an
Start -> Run and type “intl.cpl”). On the Formats tab, click “Additional settings...”. Change t

d Language” applet (or, click
he “List separator” value from

its default (usually a comma) to the caret (Shift + 6 on most US keyboards). Click OK to save the change.

FedMall QSG Catalog Template v0.1.6 document.docx
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¥ Region and Language = |
Formats | Location | Keyboards and Languages I Administrative
Format:
[English (United States) -
Date and time formats
Short date: [Mfdfym 'I
Long date: [ dddd, MMMM dd, yyyy -
Short time: [h:mm it 'l
Long time: [h:mm:sstt 'I
First day of week: [Sunday 'l
What does the notation mean?
Examples
Short date: 3/14/2016
Long date: Monday, March 14, 2016
Short time: 1:21 PM
Long time: 11:21:12 PM
Additional settings...
Go online to leam abeut changing languages and regional formats

“¥ Customize Format

Numbers | currency | Time | Date

Example
Positive:  123,456,789.00

Decimal symbol:

No. of digits after decimal:
Digit grouping symbel:
Digit grouping:

Negative sign symbol:
Negative number format:

Display leading zeros:

Negative:  -123,456,789.00

(123,456,789 -

List separator:

Measurement system:
Standard digits:

Use native digits:

numbers, currency, time, and date.

0123456783 -

Click Reset to restore the system default settings for

) (] (]

e In Excel, create your catalog. Ensure that the first row contains the column headers as listed in the “Catalog Template”
sheet. Click File -> Save As. In Save As Type, select “CSV (Comma delimited) (*.csv)”. Provide a file name and click Save.
Excel will warn you that “some features in your workbook might be lost”; click Yes to keep using this format (Excel is
warning you that some features, like formatting, won’t be saved in a text file; this is to be expected).

e  Confirm a successful export by opening the file in a plain text editor (such as Notepad). You should see the header row on
the first line followed by your data, with a caret ( * ) character separating each data field (“column”).

2.7 Maintaining Delimiters with Optional Fields

There must be a caret separating each field, even if an optional field is left blank. For example, if leaving OEM CAGE Code blank
(between OEM Part Number and OEM Name), the fields might look like this:

LWAPN123457"Company Name”..

This same principle holds true at the end of the row. For example, if you leave the last five fields blank in a given row, that row

would end with five carets (AMAAA), like this:

.."This item meets environmental regulations

AAAAA

FedMall QSG Catalog Template v0.1.6 document.docx
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2.8 Example

The first row of your .csv text file is a header row, and it should look like this:

Item Master Primary Spec/Item Status Information/Archive*ltem Master Primary Spec/Common
Information/Commercial and Government Entity Code”ltem Master Primary Spec/Common Information/Contract
Number~ltem Master Primary Spec/Common Information/Part Number~ltem Master Primary Spec/Common
Information/Part Name”ltem Master Primary Spec/Common Information/Federal Supply Class*ltem Master Primary
Spec/Pricing/Original Unit Price*ltem Master Primary Spec/Pricing/Original Unit of Issue*ltem Master Primary
Spec/Pricing/Quantity Per Unit Pack?ltem Master Primary Spec/Common Information/Original Equipment
Manufacturer Part Number?ltem Master Primary Spec/Common Information/Original Equipment Manufacturer CAGE
Code*ltem Master Primary Spec/Common Information/Original Equipment Manufacturer Name*ltem Master Primary
Spec/Short Description”ltem Master Primary Spec/Common Information/Days After Receipt of Order*ltem Master
Primary Spec/Long Description?ltem Master Primary Spec/Common Information/Universal Product Code”ltem Master
Primary Spec/Commercial Information/Environmental Information/Hazardous Material Flag*ltem Master Primary
Spec/Sale Pricing/Sale Start Date*ltem Master Primary Spec/Sale Pricing/Sale End Date*ltem Master Primary Spec/Sale
Pricing/Sale Price®ltem Master Primary Spec/Commercial Information/Shipping Information/Shipment Level of
Service/Standard Shipment Price*ltem Master Primary Spec/Commercial Information/Shipping Information/Shipment
Level of Service/Expedited Shipment Price®ltem Master Primary Spec/Commercial Information/Shipping
Information/Shipment Level of Service/Next Day Shipment Price®ltem Master Primary Spec/Special
Properties/Environmentally Preferred/Environmentally Preferred Indicator?ltem Master Primary Spec/Special
Properties/Environmentally Preferred/Justifying Comment”ltem Master Primary Spec/Special Properties/Energy
Star/Energy Star Indicator®ltem Master Primary Spec/Special Properties/Energy Star/Justifying Comment*ltem Master
Primary Spec/Special Properties/Made in the USA/Made in the USA Indicator*ltem Master Primary Spec/Special
Properties/Made in the USA/Justifying Comment~ltem Master Primary Spec/Characteristic Information

After including the header row on line 1 of your file, include one item record on each subsequent line (beginning with line 2) of the
file. The following text represents two well-formed records that will pass file upload validations (although of course the CAGE code
and contract number are fictitious). The first sample record only includes the mandatory fields; the second record has all fields
completed.

NAAB123*MARKETPLACE_AB123"PN12345AStamp, 6 Digit Numbr Pro~7510720.83"EAMN1MUSST55462"U. S. STAMP &
SIGN~Professional Numberer, Self-Inking, Type Size 1 1/2, Six Digits, Black?2/Strong and fast to tackle even the biggest
numbering jobs. Steel frame construction stands up to heavy-duty use. A self-inking pad saves time; there's no need to
stop and re-ink. Includes replaceable stamp pad that delivers up to 10,000 impressions. Stamp Type: Numberer; Ink
Types: Self-Inking; Impression Width: 1 5/8 inch; Impression Height: 3/8 inch AMAAAAAANAAANN

NAAB123AMARKETPLACE_AB1237123ABC45”Label, Heat Shrink, 1/4-inch,
WhiteA7510735.57ARO*1"DYM18051*A1B2CASANFORD LP~ARhino Heat Shrink Tubes Industrial Label Tape Cassette,
1/4 IN X 5 FT, White*1ADurable and smear-proof. Resistant to chemicals, solvents, grease, heat, moisture and other
harsh elements. Industrial-strength adhesive for labels that stick and stay stuck. Easy-to-peel split backing for simple
application. Label Size - text: 1/4 in x 5 ft.; Label Color(s): White; Machine Compatibility: Label Makers; Printed Text
Color(s): Black.A71701180513~N”2017-01-0122017-09-30729.82/24.9919.99214.992Y This item is Green
Certified"YAThis item received Energy Star Certification in 2017AYAManufactured in California with materials sourced
from Maryland*AAAB | white~~~~~ CGCY | Office supplies~~~~~ ABGL|0.25 inches~~~~~ASHR | Varies

FedMall QSG Catalog Template v0.1.6 document.docx Status: Review
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3 Field Descriptions

The following tables provides descriptions of columns in the Supplier Catalog Template.

Position

Field Name et Req Multi-

Field Description

Field Group Type Attribute Header (matches

valued?

the column headers in the

“Catalog Template” sheet)

Archive This field indicates whether Item Status STRING 1 Single Item Master Primary
the item should be marked Information value Spec/Item Status
for deletion (archive). Valid Information/Archive
values are “Y” (yes, archive;
mark as deleted in the
database) or “N” (no,
default).

Commercial The CAGE code of the Common STRING 5 Single Item Master Primary

and supplier; a 5-character Information value Spec/Common

Government alphanumeric code issued Information/Commercial

Entity Code by the US Government and Government Entity

Code

Contract The full contract number Common STRING 20 Single Item Master Primary

Number associated with this item’s Information value Spec/Common
catalog. For MarketPlace Information/Contract
catalogs without a contract, Number
use the identifier
MARKETPLACE_<CAGE>.

That is, a single underscore
character ( _ ) separates the
all-capital word
“MARKETPLACE” from the
supplier’s CAGE code (5
alphanumeric characters).
Example:
MARKETPLACE_012AB.

Part Number Your part number; the part Common STRING 80 Single Item Master Primary
number as captured by the Information value Spec/Common
vendor/supplier. Information/Part Number

Part Name Product name; the name of Common STRING 80 Single Item Master Primary
the item Information value Spec/Common

Information/Part Name

Product Service The PSC (product service Common STRING 4 Single Item Master Primary

Code code) includes all of the Information value Spec/Common
Federal Service Code (FSC) Information/Federal Supply
numbers and includes Class
additional codes; PSCs are 4
alphanumeric characters
long.

Price This is the customer cost; Pricing NUMBER 20 Single Item Master Primary
note: for FOB Destination, value Spec/Pricing/Original Unit
this price must include the Price
shipment costs. Enter the
price as a number with up
to two decimal digits; do
not include the dollar sign.

Unit of Issue This is a word such as Pricing STRING 2 Single Item Master Primary
“each,” “box,” or “carton,” value Spec/Pricing/Original Unit
to describe the unit of Issue
associated with the
quantity. Use a valid code
from the list provided in the
next sheet.

FedMall QSG Catalog Template v0.1.6 document.docx
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Supplier Catalog Template

Quantity per
Unit Pack

OEM Part

Number

OEM CAGE
Code

OEM Name

Description

Days ARO

Expanded
Description
uPC

Hazardous

Material Flag

Sale Start Date

Sale End Date

10

11

12

13

14

15

16

17

18

19

Also known as the quantity
per unit of issue; this is the
number of items in each
box, carton, etc.

The original equipment
manufacturer (OEM) part
number; do not modify with
a prefix or suffix

The original equipment
manufacturer (OEM)’s 5-
character Commercial and
Government Entity (CAGE)
code

The original equipment
manufacturer (OEM) name;
the name of the company
that manufactured the item

Detailed description of the
item (spell out key words)
Time frame from receipt of
order (ARO = After Receipt
of Order) to shipping; this is
not the same as the time
frame for the delivery of an
order.

Long description of the
item.

The universal product code
(“bar code”) number. Use
only digits 0 through 9; do
not include the hyphen (-)
character.

Indicates hazardous
material (HAZMAT)
classification. Valid values
are “Y” (yes, HAZMAT) or
“N” (no).

The date (date only, no
time) at which point the
sale price will be effective.
Use format YYYY-MM-DD,
e.g. 2015-12-17. Note: If
using Microsoft Excel to edit
the file, change the format
to “Text” (instead of “Date”
or “General”) to prevent
Excel from converting the
numbers into its own data
format.

The date (date only, no
time) at which point the
sale price will no longer be
effective. Use format YYYY-
MM-DD, e.g. 2015-12-17.
Note: If using Microsoft
Excel to edit the file, change
the format to “Text”
(instead of “Date” or
“General”) to prevent Excel
from converting the

Pricing

Common
Information

Common
Information

Common
Information

(General)

Common
Information

(General)

Common
Information

Commercial
Information

Sale Pricing

Sale Pricing

NUMBER 20
STRING 80
STRING 5
STRING 80
STRING 25
4

NUMBER 20
STRING 30
00

STRING 12
STRING 1
DATE 10
DATE 10

Single
value

Single
value

Single
value

Single
value

Single
value
Single
value

Single
value
Single
value

Single
value

Single
value

Single
value

Item Master Primary
Spec/Pricing/Quantity Per
Unit Pack

Item Master Primary
Spec/Common
Information/Original
Equipment Manufacturer
Part Number

Item Master Primary
Spec/Common
Information/Original
Equipment Manufacturer
CAGE Code

Item Master Primary
Spec/Common
Information/Original
Equipment Manufacturer
Name

Item Master Primary
Spec/Short Description
Item Master Primary
Spec/Common
Information/Days After
Receipt of Order

Item Master Primary
Spec/Long Description
Item Master Primary
Spec/Common
Information/Universal
Product Code

Item Master Primary
Spec/Commercial
Information/Environmental
Information/Hazardous
Material Flag

Item Master Primary
Spec/Sale Pricing/Sale Start
Date

Item Master Primary
Spec/Sale Pricing/Sale End
Date

FedMall QSG Catalog Template v0.1.6 document.docx
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Sale Price

Standard
Shipment Price

Expedited
Shipment Price

Next Day
Shipment Price

Environmentall
y Preferred
Indicator

Environmentall
y Preferred
Justifying
Comment

Energy Star
Indicator

Energy Star
Justifying
Comment

Made in the
USA Indicator

Made in the
USA Justifying
Comment

Characteristic
Information

20

21

22

23

24

25

26

27

28

29

30

numbers into its own data
format.

Enter the price as a number
with up to two decimal
digits; do not include the
dollar sign.

Enter the price as a number
with up to two digits after
the decimal; do not include
the dollar sign.

Enter the price as a number
with up to two digits after
the decimal; do not include
the dollar sign.

Enter the price as a number
with up to two digits after
the decimal; do not include
the dollar sign.

Indicates whether this item
is environmentally
preferred. Valid values are
“Y” (yes) or “N” (no).

Free text comments to
justify the indicator.
Required only if the
associated indicator is “Y”.

Indicates whether this item
is Energy Star certified.
Valid values are “Y” (yes) or
“N” (no).

Free text comments to
justify the indicator.
Required only if the
associated indicator is “Y”.
Indicates whether this item
is made in the USA. Valid
values are “Y” (yes) or “N”
(no).

Free text comments to
justify the indicator.
Required only if the
associated indicator is “Y”.
List of Master Requirement
Codes (MRC). Format string
as one or more code-value
pairs. Separate the code
from its value with the pipe
(|) character. Separate each
code-value pair with five (5)

tilde characters (~~~~~ ).
Format is:
codel|valuel~~~~~ code2|v

Sale Pricing

Commercial
Information

Commercial
Information

Commercial
Information

Special
Properties

Special
Properties

Special
Properties

Special
Properties

Special
Properties

Special
Properties

Characteristic
Information

NUMBER

NUMBER

NUMBER

NUMBER

STRING

STRING

STRING

STRING

STRING

STRING

STRING

20

10

10

10

30
00

30
00

30
00

13
59

Con
ditio
nal

Con
ditio
nal

Con
ditio
nal

Single
value

Single

value

Single
value

Single
value

Single
value

Single
value

Single
value

Single
value

Single
value

Single
value

Item Master Primary
Spec/Sale Pricing/Sale Price

Item Master Primary
Spec/Commercial
Information/Shipping
Information/Shipment
Level of Service/Standard
Shipment Price

Item Master Primary
Spec/Commercial
Information/Shipping
Information/Shipment
Level of Service/Expedited
Shipment Price

Item Master Primary
Spec/Commercial
Information/Shipping
Information/Shipment
Level of Service/Next Day
Shipment Price

Item Master Primary
Spec/Special
Properties/Environmentally
Preferred/Environmentally
Preferred Indicator

Item Master Primary
Spec/Special
Properties/Environmentally
Preferred/Justifying
Comment

Item Master Primary
Spec/Special
Properties/Energy
Star/Energy Star Indicator
Item Master Primary
Spec/Special
Properties/Energy
Star/Justifying Comment
Item Master Primary
Spec/Special
Properties/Made in the
USA/Made in the USA
Indicator

Item Master Primary
Spec/Special
Properties/Made in the
USA/Justifying Comment
Item Master Primary
Spec/Characteristic
Information
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alue2~~~~~ code3|value3~~
~~~code4|valued. Do not
use the delimiters (i.e. the
pipe character or five
consecutive tildes) in either
the codes or the values
provided. A maximum of
100 code-value pairs may
be included per item.
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== Supplier Catalog Template

4 Additional Information: X12 Codes

4.1 Overview

FedMall uses X12 codes on all outbound requisitions and purchase orders. For those vendors who are using the DoD codes, please
use the conversions available in the table below. All codes in vendor catalog uploads should be X12 codes as listed below.

4.2 Notes
Number of codes: 485

Reference URL: http://www.dlmso.dla.mil/eApplications/LogDataAdmin/dImsansiconverguides.asp

4.3 Codes

Notes:  The following note is provided verbatim from the source document on the DLA.mil site:
ALL X12 CODE VALUES WITHOUT TRAILING ASTERISKS (*) HAVE BEEN APPROVED BY THE ASC X12 COMMITTEE FOR USE IN
ALL VERSION RELEASES OF ANSI X12. A SINGLE ASTERISK (*) INDICATES THAT X12 CODE VALUES ARE AUTHORIZED FOR USE
IN VERSION RELEASES 005020 AND AN ALL SUBSEQUENT VERSIONS. THE X12 CODE VALUES FOLLOWED BY A DOUBLE
ASTERISK (**) HAVE BEEN APPROVED FOR VERSION RELEASE 005030 AND ALL SUBSEQUENT VERSIONS.

DOD CODE . NAME/DEFINITION X12 CODE
(for reference only) (to be used in FedMall)

sC - SECOND 3
LIFT 5
STRAND 7
9 TIRE 9

GP GROUP 10

oT OUTHIT 11

Pz PACKET 12

RA RATION 13

SO SHOT 14

SX STICK 15

17 100 POUND DRUM 17

18 55 GALLON DRUM 18

19 TANK TRUCK 19

1IN COUNT 1IN

10 SEASON 10

1P TANK CAR 1P

FR FRAME 1Q

1R TRANSACTION 1R

1X QUARTER MILE 1X

20 20 FOOT CONTAINER 20

21 40 FOOT CONTAINER 21

2D SHIP SET 2D
MB BRITISH THERMAL UNITS/HOUR 21
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DB DECIBEL 2N

KC KILOCURIE 2R

2U MEGAGRAM 2U

2w BIN 2W

43 SUPER BULK BAG (SAME SIZE AS PALLET) 43

44 500 KILOGRAM BULK BAG 44

45 300 KILOGRAM BULK BAG 45

46 25 KILOGRAM BULK BAG 46

47 50 POUND BAG a7

48 BULK CAR LOAD 48

4A BOBBIN 4A

4B CAP 4B

4E 20-PACK 4E

4F 100-PACK 4F

4G MICROLITER 4G

51 ACTUAL TONNES 51

57 MESH 57

58 NET KILOGRAMS 58

5B BATCH 5B

5D PROOF GALLONS 5D

5G PUMP 5G

5H STAGE 5H

5l STANDARD CUBE FOOT 51

VT VOLT 70

7A LANDINGS 7A

7C FLIGHT HOURS 7C

8C CORD 8C

8D DUTY 8D

8P PROJECT 8P

8R PROGRAM 8R

8s SESSION 8S

K2 SQUARE KILOMETER 8uU

91 STOKE 91

94 CURL UNIT 94

95 20,000 GALLON TANKCAR 95

96 10,000 GALLON TANKCAR 96

97 10 KILOGRAM DRUM 97

98 15 KILOGRAM DRUM 98

WT WATT 99

AP APOTHECARY POUND 9A (X12 VERSION RELEASE 005020

MIGRATION CODE. REFER TO ADC 1008.)
BQ BRIQUET 9B (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)

FD FOLD 9F (X12 VERSION RELEASE 005020

MIGRATION CODE. REFER TO ADC 1008.)
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AO APOTHECARY OUNCE 90 (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)

PI PILLOW 9P (X12 VERSION RELEASE 005030
MIGRATION CODE. REFER TO ADC 1008.)

ST SEAT 95 (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)

9y FAMILY UNIT 9y

us USP UNIT 9Z (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)

BA BALL AA

AB BULK PACK AB

AC ACRE AC

YT BYTE AD

cG CENTIGRAM AF

AJ COP (CYLINDRICAL OR CONICAL MASS) Al

FA FATHOM AK

AL ACCESS LINES AL

AM AMPOULE AM

AR SUPPOSITORY AR

AT ASSORTMENT AS

AV CAPSULE AV

AW POWDER-FILLED VIAL AW

AX TWENTY AX

AY ASSEMBLY AY

BO BRITISH THERMAL UNITS PER CUBIC FOOT BO

BY BUNK B2

B3 BATTING POUND B3

B4 BARREL IMPERIAL B4

B5 BILLET BS

B6 BUN B6

B7 CYCLE B7

B8 BOARD B8

B9 BATT B9

BE BALE BA

BB BASS BOX BB

BC BUCKET BC

BD BUNDLE BD

BM BEAM BE

BF BOARD FOOT BF

BG BAG BG

BH BRUSH BH

BR BAR BI

B BAND BJ

BK BOOK BK

BZ BLOCK BL

BO BOLT BM
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BN BULK BN
BT BOTTLE BO
BP 100 BOARD FEET BP
BL BARREL BR
BS BASKET BS
Bl BELT BT
BU BUSHEL (32 DRY QUARTS) BU
BV BUSHEL DRY IMPERIAL BV
BW BASE WEIGHT BW
BX BOX BX
ZF MILLION BTUS/DEKATHERM BZ
co CALLS co
C1 COMPOSITE PRODUCT POUNDS (TOTAL WEIGHT) c1
c7 CARSET Cc2
ca CARLOAD c4
Cc5 COST C5
Cc6 CELL (&9
cs8 CUBIC DECIMETER c8
c9 COIL GROUP Cc9
CS CASE CA
CcB CARBOY CB
cc CUBIC CENTIMETER CcC
KR KARAT (CARAT) CcD
CF CUBIC FOOT CF
cQ CARD CG
co CONTAINER CH
Cl CUBICINCH Cl
CE CONE (o]
CR CONNECTOR CK
CcY CYLINDER CL
™M CENTIMETER CcM
CN CAN CN
cp CRATE Ccp
CA CARTRIDGE cQ
cz CUBIC METER CR
CcX CASSETTE (&)
CcT CARTON CcT
cuU CuUP Cu
cv COVER cv
HP HUNDRED POUNDS Ccw
CL COIL CcX
cD CUBIC YARD Cy
c3 COMBO Ccz
DA DAY DA
DM DRAM DF
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DG DECIGRAM DG
mi MILE DH
DI DISPENSER DI
DC DECAGRAM DJ
KM KILOMETER DK
DL DECILITER DL
DE DECIMETER DM
DO DOLLARS U.S. DO
DP DOZEN PAIR DP
DQ DATA RECORD DQ
DR DRUM DR
DS DISPLAY DS
DT DRY TON DT
DU DYNE DU
DK DEGREES, KELVIN DV
DX CALENDAR DAYS (NUMBER OF) DW
DY DIRECTORY BOOKS DY
Dz DOZEN Dz
E1l HECTOMETER El
EA EACH EA
EB ELECTRONIC MAIL BOXES EB
EE EMPLOYEES EE
EH KNOTS EH
EJ LOCATIONS EJ
EP ELEVEN PACK EP
EQ EQUIVALENT GALLONS EQ
EV ENVELOPES EV
U INTERNATIONAL UNIT F2
F4 MINIM F4
F6 PRICE PER SHARE F6
DF FAHRENHEIT FA
FB FIELDS FB
FC 1000 CUBIC FEET FC
FE TRACK FOOT FE
FF HUNDRED CUBIC METERS FF
FG TRANSDERMAL PATCH FG
FJ SIZING FACTOR FJ
FK FIBER FK
FL FLAKE TON FL
FM MILLION CUBIC FEET FM
FO FLUID OUNCE FO
FT FOOT FT
FU FURLONG FU
GB GALLONS PER MINUTE G2
Gl GILL (IMPERIAL) G5

FedMall QSG Catalog Template v0.1.6 document.docx

Status: Review
Page 19 of 26



Supplier Catalog Template

GL GALLON GA

GG GREAT GROSS GG

IG IMPERIAL GALLON Gl

GM GRAM GR

GR GROSS GS

GN GRAIN GX

H2 HALF LITER H2

H4 HECTOLITER H4

HK HANK HA

HX HUNDRED BOXES HB

HC HUNDRED COUNT HC

HZ HALF DOZEN HD

HF HUNDRED FEET HF

HG HECTOGRAM HG

HA HUNDRED CUBIC FEET HH

HI HUNDRED SHEETS HI

KH HUNDREDS OF KILOGRAMS HK

HL HUNDRED FEET (LINEAR) HL

HO HUNDRED TROY OUNCES HO

HQ HECTARE HQ

HR HOUR HR

HS HUNDRED SQUARE FEET HS

HT HALF HOUR HT

HD HUNDRED HU
HW HUNDRED WEIGHT — SHORT (HUNDRED WEIGHT) HV
cw HUNDRED WEIGHT (LONG) HW

HB HOSPITAL BEDS HX (X12 VERSION RELEASE 005020

MIGRATION CODE. REFER TO ADC 1008.)

HY HUNDRED YARDS HY

11 PERSONS, CAPACITY

PX PELLET 12 (X12 VERSION RELEASE 005030

MIGRATION CODE. REFER TO ADC 1008.)

PN PERSON IE

IH INHALER IH

M IMPRESSION IM

IN INCH IN

1P INSURANCE POLICY IP

IS STOP IS

JB JOB JA

JU JUMBO IB

JOo JOINT JO

JR JAR JR

JG JUG JU

K6 KILOLITER K6

K7 KILOWATT K7
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KV KILOVOLT K8 (X12 VERSION RELEASE 006050
MIGRATION CODE. REFER TO ADC 1008.)
K CAKE KA
KE KEG KE
KF KILOPACKET KF
KG KILOGRAM KG
Kz KILOWATT-HOUR KH
KK 100 KILOGRAMS KK
KT KIT KT
KU TASK KU
DK KELVIN KV
L5 LITERS AT 15 DEGREES CELSIUS L5 (LOCAL CODE SUBMITTED FOR INCLUSION
IN X12. REFER TO ADC 1108.)
LB POUND (AVOIRDUPOIS) LB
LE LITE LE
LF LINEAR FOOT LF
Lo LONG TON LG
LN LINEAR INCH L
u LARGE SPRAY L
LK LINK LK
LM LINEAR METER LM
LG LENGTH LN
LT LoT Lo
LR LAYER LR
LS LUMP SUM LS
U LITER LT
LY LINEAR YARD LY
Mo MAGNETIC TAPE MO
M3 MAT M3
M5 MICROGRAM MC
MD AIR DRY METRIC TON MD
MG MILLIGRAM ME
M) METRIC GROSS TON MG
MH METRIC Ml
MT MINUTE M
ML MILLILITER ML
MM MILLIMETER MM
MA METRIC NET TON MN
MO MONTH MO
M6 METRIC TON MP
mQ 1000 METERS MQ
MR METER MR
MS SQUARE MILLIMETER MS
MK METRIC LONG TON MT
Mz MIXED MX

FedMall QSG Catalog Template v0.1.6 document.docx

Status: Review
Page 21 of 26



Supplier Catalog Template

N2 NUMBER OF LINES N2

N7 PART N7

N9 CARTRIDGE NEEDLE N9

NB BARGE NB

NC CAR NC

ND NET BARRELS ND

NE NET LITERS NE

NF MESSAGES NF

NG NET GALLONS NG

NI NET IMPERIAL GALLONS NI

NJ NUMBER OF SCREENS NJ

NK NIGHTS NK

NL LOAD NL

NM NAUTICAL MILE NM

NN TRAIN NN

NS SHORT TON NS

NT TRAILER NT

NV VEHICLE NV

NX PARTS PER THOUSAND NX

GT THOUSAND GALLONS PER DAY NZ (X12 VERSION RELEASE 005030
MIGRATION CODE. REFER TO ADC 1008.)

OA PANEL OA

oL OUTLET OB (X12 VERSION RELEASE 005030
MIGRATION CODE. REFER TO ADC 1008.)

ocC BILLBOARD ocC

GX APOTHECARY GRAIN OG (X12 VERSION RELEASE 005030
MIGRATION CODE. REFER TO ADC 1008.)

opP TWO PACK op

ou OPERATING UNIT OU (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)

oz OUNCE - AV 0oz

PO PAGE - ELECTRONIC PO

P1 PERCENT P1

P2 POUNDS PER FOOT P2

P3 THREE PACK P3

P4 FOUR PACK P4

P5 FIVE PACK P5

P6 SIX PACK P6

P7 SEVEN PACK P7

P8 EIGHT PACK P8

P9 NINE PACK P9

PL PAIL PA

PB PAIR INCHES PB

PC PIECE PC

PD PAD PD

PE POUNDS EQUIVALENT PE
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PF PALLET (LIFT) PF
PO POUNDS GROSS PG
PH PACK (PAK) PH
PY PITCH PI
PG PACKAGE PK
PJ PALLET/UNIT LOAD PL
PS POUNDS NET PN
PM PLATE PP
PR PAIR PR
PT PINT PT
PU MASS POUNDS PU
PV HALF PINT PV
PP PINT IMPERIAL PX
PK PECK DRY US PY
PQ PECK DRY IMPERIAL PZ
ME MEAL Q3
FY FIFTY Q4
TF TWENTY-FIVE Qs
TS THIRTY-SIX Q6
™D TWENTY-FOUR Q7
FV FIVE Q9 (X12 VERSION RELEASE 005030
MIGRATION CODE. REFER TO ADC 1008.)
ac CHANNEL Qc
Qu QUARTER DOZEN Qb
QE PHOTOGRAPHS QE
QF QUARTER QF **
QK QUARTER KILOGRAM QK
QR QUIRE QR
Qs QUART DRY U.S. Qs
ar QUART Qrt
al QUART IMPERIAL Qu
R4 CALORIE R4
R5 THOUSANDS OF DOLLARS R5
R9 THOUSAND CUBIC METERS R9
RR RACK RA
RB RADIAN RB
RC ROD (AREA) - 16.25 SQUARE YARDS RC
RD ROD (LENGTH) - 5.5 YARDS RD
RL REEL RE
RG RING RG
RH RUNNING OR OPERATING HOURS RH
RK ROLL-METRIC MEASURE RK
RO ROLL RL
RM REAM RM
RN REAM-METRIC MEASURE RN
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RE ROUND RO
RP POUNDS PER REAM RP
RS RESETS RS
RT REVENUE TON MILES RT
RU RUN RU
RX THOUSAND ROUNDS RX
S5 SIXTY-FOURTHS OF AN INCH S5
S6 SESSIONS S6
S7 STORAGE UNITS S7
SwW STANDARD ADVERTISING UNIT S8
S9 SLIP SHEET S9
SA SANDWICH SA
M2 SQUARE MILE SB
c2 SQUARE CENTIMETER SC
SN SECTION (640 ACRES OR ONE SQUARE MILE) SE
SF SQUARE FOOT SF
SG SEGMENT SG
SH SHEET SH
Sl SQUARE INCH S|
SJ SACK SJ
SR SPLIT TANKTRUCK SK
sV SLEEVE SL
SM SQUARE METER SM
SU SQUARE ROD SN
SL SPOOL SO
S8 SHELF PACKAGE SP
sQ SQUARE sQ
SP STRIP SR
SS SHEET-METRIC MEASURE SS
SE SET ST
SD SKID sV
SK SKEIN SW
SB SHIPMENT SX
SY SQUARE YARD SY
Sz SYRINGE Sz
T1 THOUSAND POUNDS GROSS T1
T3 THOUSAND PIECES T3
T4 THOUSAND BAGS T4
T5 THOUSAND CASINGS T5
T6 THOUSAND GALLONS T6
T7 THOUSAND IMPRESSIONS T7
T8 THOUSAND LINEAR INCHES T8
T9 THOUSAND KILOWATT HOURS/MEGAWATT-HOUR T9
TA TENTH CUBIC FOOT TA
TU TUBE B
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TC TRUCK LOAD TC
G GROSS TON TG
MX THOUSAND TH
Tl THOUSAND SQUARE INCHES Tl
T THOUSAND SQUARE CENTIMETERS T
TK TANK K
MF THOUSAND FEET TL
™ THOUSAND FEET (BOARD) ™
™ NET TON (2,000 POUNDS) N
TO TROY OUNCE TO
v TEN-PACK P
TQ THOUSAND FEET TQ
TR TEN SQUARE FEET R
Z THOUSAND SQUARE FEET TS
it THOUSAND LINEAR METERS T
™ THOUSAND LINEAR YARDS TU
TH THOUSAND KILOGRAMS v
™w THOUSAND SHEETS ™W
1 TROY POUND ™
v TRAY Y
mc THOUSAND CUBIC FEET Z
u1 TREATMENT u1
i TABLET U2
TE TEN u3
us TWO HUNDRED FIFTY us
173 UNITED STATES GALLONS @ 60 DEGREES U6 (MIGRATION CODE APPROVED FOR
FAHRENHEIT VERSION TO BE PUBLISHED JAN 2014. REFER TO
ADC 1008.)

UH TEN THOUSAND YARDS UH
uL UNITLESS uL
um MILLION UNITS um
UN UNIT UN
up TROCHE uP
ua WAFER ua
AD APOTHECARY DRAM UX
Vi FLAT Vi
V2 POUCH V2
s FIVE HUNDRED vC
Vi VIAL Vi
Vs VISIT Vs
w2 WET KILO w2
wB WET POUND WB
wD WORK DAY WD
WE WET TON WE
WG WINE GALLON WG
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WH WHEEL WH

WK WEEK WK

DW PENNYWEIGHT WP

WR WRAP WR

CH CHAIN X1

X2 BUNCH X2

X3 CLOVE X3

X4 DROP X4

X5 HEAD X5

X6 HEART X6

X7 LEAF X7

X8 LOAF X8

X9 PORTION X9

Y1 SLICE Y1

B TABLESPOON Y2

T2 TEASPOON Y3

Y4 TUB Y4

YD YARD YD

YL 100 LINEAL YARDS YL

YR YEAR YR

1 LIFT VAN Z1

22 CHEST z2

Z3 CASK Z3

HH HOGSHEAD 4

Z5 LUG Z5

PA PAGE ZP

B2 BARREL, DRY ZW (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)

B1 BARREL, LIQUID ZX (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)

AS APOTHECARY SCRUPLE ZY (X12 VERSION RELEASE 005020
MIGRATION CODE. REFER TO ADC 1008.)
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